Vodafone Mobile Connect

Quick Installation Guide

Important
Install software before inserting data card or attaching USB modem or phone
Welcome to the world of mobile communications!
Once you have installed the Vodafone Mobile Connect software you will be able to:

– Make mobile data connections over the Vodafone mobile phone network, e.g. to browse the internet, or to pick up your email
– Write and receive SMS text messages with your computer†
– Monitor approximately how much data you transfer, and how long you connect.

In addition, the Vodafone Mobile Connect software includes optimisation software. This speeds up any mobile data connection opened using the program.

To use this software, you need:

– A computer running Microsoft® Windows Vista ™, Windows® XP or Windows® 2000, or a computer running Mac OS® X 10.3.5 or above.
– A CD drive
– At least 100 MB free disk space and 128 MB RAM

Depending on the device you wish to use with the Vodafone Mobile Connect software, you will also need:

– A Type II PC Card (PCMCIA) slot, supporting CardBus
– An Expresscard slot
– A USB or USB 2.0 socket
– A Bluetooth-enabled computer and device
– A computer with a built-in data card.

Ensure you read and observe the manufacturer’s precautions and safety information provided with your chosen device.

† SMS is currently only supported on computers running Microsoft Windows.
01
Install the software and re-start your computer.
Do not insert your data card or attach your device before you have installed the software. If you have already inserted your data card, please remove it. Similarly, if you had already attached your USB modem, please detach it.
Insert the Vodafone Mobile Connect software CD and follow the on-screen installation instructions.
When installation is complete, you will be asked to re-start your computer before proceeding with steps 02 and 03.

02
Insert your SIM into your data card or device.
Your SIM (Subscriber Identity Module) is the small, postage-stamp–sized chip that you received together with your mobile subscriber contract.
Make sure the gold contacts on your SIM match up with the contacts on your device, and your SIM is aligned as shown in the illustration on the device.
If you are using the software on a notebook with a built-in data card, the SIM may already be present.

03
Insert or attach your device when prompted.
After you have installed the software, and your computer has re-started, start the Vodafone Mobile Connect software and follow the on-screen instructions to set up your device.
If you need to make any changes to the way your device is set up, e.g. special network settings or similar, you can select the device in the “Manage Devices” view and edit settings later.
01 Install the software and re-start your computer.

02 Insert your SIM into your device, e.g. your data card.

03 Attach or insert your device when prompted.

Tip:
- Look for the illustration on your data card, USB modem or phone.
- Make sure the gold contacts on your SIM will touch the contacts on your device.
- Check the cut-away corner of your SIM is aligned with the shape of the SIM slot on your device.
The Vodafone Mobile Connect software is designed to let you perform the most common actions by clicking on a single button.

**Software Overview**

01 **Settings**
Additional software settings

02 **Support**
Hotline and internet contact details

03 **Connect/Disconnect**
Connect via the mobile phone network

04 **Start SMS program**
Send, receive and manage SMS text messages

05 **Status**
Check the status of your mobile device and the mobile network.

**Tip:**
The Help Topics in the Help menu contain details of all the features of Vodafone Mobile Connect. The Help items are written to explain features clearly, and laid out for easy on-screen reading.
Open a Mobile Connection

Tip:
You can check the strength of the mobile network signal by looking at the symbol to the left of the "Mobile Connections" Connect button or looking at the icon in the Windows Notification area. The more bars that are filled in, the better the signal quality.

Mobile Connections

If a mobile network has been found, the Connect button in the "Mobile Connections" panel will be enabled. Click this button to open a connection to the internet via the mobile phone network.

When connected, the Connect button text changes to "Disconnect", a green indicator will appear below the button, and the Mobile Connections icon will be animated. Clicking the same button again will then close the connection.

To open a mobile connection, you must be within coverage of a mobile network. As a rule, anywhere you can make a call on your mobile phone, you should be able to open a data connection with the Vodafone Mobile Connect software.

To browse web pages or collect your email, you need to connect to the internet. The Vodafone Mobile Connect software provides a button to open such a connection. When you have started the program, and have the main window open, you will see the Connect button in the panel entitled "Mobile Connections".

If a mobile network has been found, the Connect button in the "Mobile Connections" panel will be enabled. Click this button to open a connection to the internet via the mobile phone network.

When connected, the Connect button text changes to "Disconnect", a green indicator will appear below the button, and the Mobile Connections icon will be animated. Clicking the same button again will then close the connection.

To open a mobile connection, you must be within coverage of a mobile network. As a rule, anywhere you can make a call on your mobile phone, you should be able to open a data connection with the Vodafone Mobile Connect software.
Main Window
You do not need to have the main program window open all the time the software is running, as closing it does not exit the program.

Mini-Window
The mini-window is just large enough to give you complete details of the current connection.

Windows Notification Area
The Vodafone Mobile Connect software displays an icon in the Windows Notification area. This program icon shows mobile signal strength, and connection status.

Right-clicking on the icon opens a menu containing the main program commands, such as Connect, Disconnect and Exit. You can therefore manage your connections without any windows open at all.

Vodafone SMS Icon
An SMS icon is displayed in the Notification area if one or more SMS text messages have been received. When an SMS is received, a popup window appears with the text of the message. You can click on this popup to respond to the SMS.

Tip:
To exit the software completely, open the File menu, or right-click the Notification area icon, and then select “Exit.”

The SMS popup window will fade out by itself if ignored. The SMS icon will remain to show that an SMS has been received.
With the Vodafone Mobile Connect software, you can send and receive SMS (Short Message Service) text messages straight from your computer. The program provides an easy way to view messages you have received, write new messages, and manage contact details for frequently-used SMS numbers.

**SMS Inbox**

Click “Vodafone SMS” on the navigation bar – on the left-hand side of the main window – to open Vodafone SMS. Click “New” at the left-hand end of the SMS toolbar to create a new SMS text message. After your SMS has been sent, it will be stored in the “Sent” list.

**New SMS**

Enter the recipient(s) here

Write your text message here

Click on “Send”

**Tip:** Just as you do not need to make a call to send an SMS from a phone, you do not need to open a connection to send an SMS with the Vodafone Mobile Connect software.
On the left-hand side of the Vodafone SMS window is the SMS navigation bar. Click “Contacts” on the SMS navigation bar to open the Contacts list, in which you can manage names and numbers that you use frequently.

**SMS Contacts**

![SMS Contacts Window]

**Tip:**
Enter your contact numbers in international format, e.g. +9198377000

Clicking the “New” button on the SMS toolbar will now open a new contact window.

**New SMS Contact**

![Create New Contact]

Enter name

Vikas Joshi

Enter number

+919837710387

Click “OK”

OK  Cancel
01
Install the software and re-start your Mac.
Insert the Vodafone Mobile Connect software CD, double-click the VodafoneMC_Installer program, and follow the on-screen installation instructions.
When installation is complete, you will be asked to re-start your Mac before proceeding with steps 02 and 03.

02
Insert your SIM into your data card or device.
Your SIM (Subscriber Identity Module) is the small, postage-stamp–sized chip that you received together with your mobile subscriber contract.
Make sure the gold contacts on your SIM match up with the contacts on your device, and your SIM is aligned as shown in the illustration on the device.

03
Attach or insert your device to your Mac.
After you have installed the software, and your Mac has re-started, attach your USB modem, or insert your mobile data card.
Double-click the Vodafone Mobile Connect program icon, wait while the software sets up your connection, and then click Activate. The very first time you run the software, it will ask for your administrator password.
You are now ready to connect. Start the "Internet Connect" program in your Applications folder, and click Connect.
After the initial installation, whenever you want to connect:
  – Start Vodafone Mobile Connect to set up your connection
  – Click Activate
  – Connect using the Internet Connect program.

Tip:
In the Internet Connect program window, there is an option to show device status in menu bar. Selecting this checkbox will constantly show the connection status of your device on the Finder menu bar, including the length of time you have been connected.
01
Install the software and re-start your computer.

02
Insert your SIM into your device, e.g. your data card.

03
Attach or insert your device and start the software.
If no device can be found
Occasionally, when you have attached or installed a data card, USB modem or phone, the Vodafone Mobile Connect software may not recognise or find it.
– Remove or shut down other devices that may be attached, e.g. Bluetooth devices
– Re-start the Vodafone Mobile Connect software
– Remove and re-attach your mobile phone, modem or data card
– Re-start your computer
– (Windows) Click “Manage Devices”, delete the current device from the list, and then add it back in again.

If no network can be found
– Change your physical location: in a building, move closer to a window, move higher up, or go outside
– (Windows) Select “View/View Available Mobile Connections” and see if you can connect to a particular network in the list shown
– Contact Support, and check that data services and roaming are enabled on your account.

If no connection can be opened
– Wait a few minutes and try to connect again. This is most often a temporary problem, especially if an “Error 31” or “Error 619” is referenced
– Re-start the Vodafone Mobile Connect software and your mobile phone, modem or data card
– Re-start your computer
– (Windows) Click “Manage Connections” and select a different Network Preference in the drop-down menu in the Mobile Connections panel
– (Mac) Start Vodafone Mobile Connect, and select one of the other options in the lower part of the main window, e.g. “3G Only”.
– If you are using a VPN (Virtual Private Network), contact your company IT administrator
– Contact Support.

If your SIM is not activated
– Refer to your computer handbook for details of how to activate your SIM, or call your mobile network operator’s Activation Hotline.
If you have problems when roaming
– (Windows) Select “View/Available Mobile Connections” and try opening one of the connections shown.
– Contact Support, and check roaming is enabled for your account.
When roaming, try and stay on a Vodafone or partner network. A “Welcome SMS” is usually sent to remind you of this. Check the name of the Vodafone network or partner in the Mobile Connections panel or the mini-window.
Selecting a particular network type may improve connection stability
At the limit of some network coverage areas, setting your network preference to “GPRS Only” or “3G Only” may give better results.
– (Windows) Click “Manage Connections” and select a different Network Preference in the drop-down menu in the Mobile Connections panel.
– (Mac) Start Vodafone Mobile Connect, and select one of the other options in the lower part of the main window, e.g. “3G Only”.
– Switch back to your normal preference when you move locations.
Remove your data card when not in use
This helps to avoid damage to your card or to the internal connectors of your laptop.
Check software update preferences
When connecting with the Vodafone Mobile Connect software it is a good idea to set both your operating system and other programs to notify you of software updates instead of downloading them automatically. If updates are downloaded automatically, they may slow down your mobile connection, or exceed your data usage limit.
Usage indication
The usage window only displays an indication of your data usage. Please refer to your invoice for the actual amount of data transferred.
<table>
<thead>
<tr>
<th><strong>Activation</strong></th>
<th>In order to open a mobile connection, the Subscriber Identity Module (SIM) in your device must be activated. If you see a message that your SIM needs to be activated, just call your mobile network operator's Activation Hotline to set up an account.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Built-in data card</strong></td>
<td>Mobile data card built into notebook computer. Enables data connections over the mobile phone network.</td>
</tr>
<tr>
<td><strong>Data card / USB modem</strong></td>
<td>A device for a notebook computer that is used to open a data connection over the mobile phone network.</td>
</tr>
<tr>
<td><strong>Dual-band</strong></td>
<td>Refers to the frequency bands supported by a mobile device for GPRS and SMS (Short Message Service) in different world regions. 3G/UMTS has a single band worldwide. Most commonly, dual-band refers to the two bands used in most European networks (900 MHz/1800 MHz); tri-band adds support for networks in North America (1900 MHz); while quad-band adds further support for networks operating in the 850 MHz band (principally Latin America).</td>
</tr>
<tr>
<td><strong>EDGE</strong></td>
<td>An enhancement to GPRS networks offering higher speeds, although not as fast as those provided by 3G/UMTS, or 3G Broadband/HSDPA.</td>
</tr>
<tr>
<td><strong>EV-DO</strong></td>
<td>A high-speed mobile data standard used mostly in the USA. Frequent travellers to the USA should contact their mobile network operator about using special Vodafone Mobile Connect data cards and software in the USA.</td>
</tr>
<tr>
<td><strong>GPRS</strong></td>
<td>Standard for transmitting data over mobile telecommunications (GSM) networks. It generally provides wide coverage and moderate data speeds. (General Packet Radio System).</td>
</tr>
<tr>
<td><strong>GSM</strong></td>
<td>A widely-used standard for mobile telecommunications (Global System for Mobile communications). According to the GSM Association, GSM technology is supported by over 680 operators in 210 countries and territories.</td>
</tr>
<tr>
<td><strong>3G/UMTS</strong></td>
<td>Often referred to as the 3rd Generation of GSM technologies, UMTS (Universal Mobile Telecommunications System) provides higher data speeds.</td>
</tr>
<tr>
<td><strong>HSDPA / 3G Broadband</strong></td>
<td>An evolution of 3G/UMTS to provide faster data speeds. Like many fixed-line &quot;broadband&quot;services, High-Speed Downlink Packet Access (3G Broadband) provides a faster download speed than upload speed.</td>
</tr>
<tr>
<td><strong>Roaming</strong></td>
<td>Connecting via networks other than your own operator’s network. This typically occurs when you are abroad, but is also possible in your own country.</td>
</tr>
<tr>
<td><strong>SIM</strong></td>
<td>The &quot;Subscriber Identity Module&quot; is the small, postage-stamp–sized chip that you will have received together with your mobile subscriber contract. The SIM has gold contacts on one side.</td>
</tr>
</tbody>
</table>
Attention
Ensure you read and observe the manufacturer’s precautions and safety information provided with your computer, data card, USB modem or phone.
For immediate assistance with installing the software and using a Vodafone Mobile Connect data card, USB modem, built-in data card or phone, call Support at your mobile network operator. You will find the Support number on the CD in the support folder, or in the software in the Help menu.

Standard and roaming call charges apply.

If you have access to the internet, you may be able to resolve any questions more quickly by visiting the Vodafone Mobile Connect website, at www.business.vodafone.com